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The Stallion Contract system is an optional module that is available to 
users of the HFM Syndicate System.  If you would like more information 
about this module, please contact our sales department. 

 

 

After the Stallion Contract Module has been installed you should take the 
following basic steps in order to set up and begin using Stallion Contracts. 
 
Please keep in mind that some steps must be completed before you can 
continue to the next step.  For example, you will need to set up your 
Season Book File with defined Stud Fee Terms Codes before you can 
actually create a contract. 
 
 

(Stallion > Stud Fee > Stud Fee Terms) 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
▪ Select “Stallion” and then select “Stud Fee”. 

 
▪ Select "Stud Fee Terms" to open the Stud Fee Terms Entry/Edit form. 
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▪ Review the Stud Fee Terms that you may have already entered into 
the system. 

 
▪ Click “Edit” to edit an existing Stud Fee Term. 

 
▪ If needed, click the button “Add” to add additional Stud Fee Terms. 

 
▪ Each contract that you plan to create should have a corresponding 

Stud Fee Term. 
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▪ Enter a description for the Stud Fee Terms 
 
▪ If this is a Stands & Nurse Term, enter either the number of days or the 

number of months to calculate when the invoice will be due.   
 
▪ Invoice only if mare status is:  Select a final status from the drop down 

menu or leave this field blank.  If left blank, the system will invoice 
every mare that was bred regardless of her final status. 
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(Contracts > Contract Setup) 
  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

▪  Select “Contracts” then select “Contract Setup” 
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• Contract Letter Template 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
▪ First create your Contract Letter Template. 

 
▪ Click the “Create” button in the Contract Letter Template section. 
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▪ Begin typing the Contract Letter Template, inserting fields from the 
“Insert” menu as you need them. 
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▪ When you have finished typing your Contract Letter Template click 
“Save”.   
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▪ By default your Contract Letter Template  will be saved in your 
designated Save Folder as an rtf file.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

▪ The location of your Save Folder can be found in your Preferences – 
Company Settings. 
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▪ When your Contract Letter Template has been saved, close the HFM 
Contract Viewer/Editor.   
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▪ If you need to make any changes, corrections or updates to the Contract 
Letter Template, click “Edit”, make your changes and click “Save”. 

 
▪ If you want to completely remove the current  Contract Letter Template 

and start over, click “Remove”. 
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• Terms Code Templates 

 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 

▪ Next create your Terms Code Templates 
 

▪ For each Stud Fee Term that you have listed you will be creating a 
corresponding contract. 
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▪ First select a Stud Fee Term from the drop down list in the Terms Code 
Templates section and then click the “Create” button.  Remember, you 
will be creating a separate Terms Code Template for each of your Stud 
Fee Terms. 
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▪ Begin typing the Terms Code Template based on the Stud Fee Term that 
you selected, inserting fields from the “Insert” menu as you need them. 
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▪ When you have finished typing your Terms Code Template click        
“Save” 
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▪ By default your Terms Code Template will be saved in your designated 
Save Folder as an rtf file.  
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 

▪ The location of your Save Folder can be found in your Preferences – 
Company Settings. 
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▪ When your Terms Code Template has been saved, close the HFM 

Contract Viewer/Editor. 
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▪ If you need to make any changes, corrections or updates to the Terms 
CodeTemplates, select the Stud Fee Term then click “Edit”. Make your 
changes for that Stud Fee Term Template and click “Save”. 

 
▪ If you want to completely remove any of the Terms CodeTemplates and 

start over, first select the Stud Fee Term then click “Remove”. 
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• Commission Agreement Template 

 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

▪ Next create your Commission Agreement Template 
 

▪ Click the “Create” button in the Commission Agreement Template 
section 
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▪ Begin typing the Commission Agreement Template, inserting fields from 
the “Insert” menu as you need them. 
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▪ When you have finished typing your Commission Agreement Template 
click “Save”. 
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▪ By default your Commission Agreement Template will be saved in your 
designated Save Folder as an rtf file.  

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

▪ The location of your Save Folder can be found in your Preferences – 
Company Settings. 
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▪ When your Commission Agreement Template has been saved, close 

the HFM Contract Viewer/Editor.  
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▪ If you need to make any changes, corrections or updates to the 
Commission Agreement Template, click “Edit”, make your changes and 
click “Save”. 

 
▪ If you want to completely remove the current  Commission Agreement 

Template and start over, click “Remove”. 
 
 

■ ■ ■ ■ ■ 
 
 

▪ Once you have created and saved your templates, their locations will be 
displayed in the corresponding template field 
 

▪ If you have already created a Template and saved it elsewhere on your 
computer, you can click on “Find”, select the file, and then save it as an rtf 
file for use in this contract module. 
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Season Book File 

(Stallion > Season Book) 
 

▪ Select “Stallion” then “Season Book” 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

▪ Select the Stallion Name 
▪ Select the Season Year and Hemisphere 
▪ Select the Share/Season Number and click “Edit” 
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Season Book File Entry General Information 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

▪ Status:  [Optional] Select the Status of the Share/Season from the drop 
down list.  

▪ Status Date:  [Optional] This is a very flexible field that can be used to 
record any number of transaction dates.  You can use it to record the date 
the client contacted you or the date you mailed the contract or the date 
you received the contract or the date the client signed the contract. 

▪ Default Stud Fee: [Optional] Automatically populates from the Stallion 
Information Entry/Edit page. 

▪ Up Front Amount: [Optional] Automatically populates from the Stallion 
Information Entry/Edit page. 

▪ Mare Name:  From the drop down list select the name of the Mare that will 
be bred to this Stallion on this share/season for the Selected Season 
Year. 

▪ Confirmed By:  [Optional] Usually the name or initials of the person that 
confirmed/authorized the contract to be created. 

▪ Confirmed On:  [Optional] Usually the date you were notified that the 
contract was confirmed/authorized. 

▪ Share/Stallion Ownership:  Indicates who owns the stallion such as a  
Syndicate, or individual owners.  If the stallion is Syndicated the Share will 
be assigned to a specific Shareholder.  

▪ Note:  The “Auto-Fill” button will auto-fill the ownership information that is 
found in the Horse Master File.  
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Creating Contracts 

Once you have entered the general information in the Season Book File you can 
begin creating contracts. 
 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

▪ Click on the Purchaser tab.  Click “New”  
▪ Sold Date:  This is a very flexible field that can be used to record any 

number of transaction dates.  You can use it to record the date the client 
contacted you or the date you mailed the contract or the date you received 
the contract or the date the client signed the contract. 

▪ Sold To: This is the name of the person or entity that owns the mare 
and/or the name of the person or entity that will be invoiced for this 
season/share.  This is the name of the person or entity that will appear on 
the Contract.  Click on the button and select the name of the client from 
your client master list.  

▪ Sold By:  Enter the name of the person or company that sold this season. 
▪ Bill:  The system defaults with a check in the “Bill” box to indicate that the 

person/company in the “Sold To” field will be invoiced for this stud fee. 
▪ Amount:  Enter the Stud Fee amount to be invoiced.  This is amount that 

will appear on the contract. 
 
 
 
 
 
 



STALLION CONTRACT MODULE 
 

Page 30 of 65 The Jockey Club Information Systems, Inc. Date: 07/01/17 

 

▪ Due Date:  Enter the date this stud fee is due (9/01/17, 11/01/17, etc.). If 
this Stud Fee is payable “Stand & Nurse” and you have designated that 
the system will automatically calculate and enter the due date for you 
based on the mare’s last day bred, leave this field blank. 

o If you select the Terms Code “Stands and Nurses” you do not have 
to fill in the due date as the due date will be automatically 
calculated and inserted into the field based on the Invoice Due Date 
information that you have entered. (See Sample Stud Fee Terms 
Entry). 

▪ Terms Code:  Select the correct Stud Fee Terms Code from the drop 
down list (Payable September 1, Stands & Nurses, No Guarantee, etc.).  

 
▪ The “Create” button creates a Stud Fee Invoice. It is not used to create 

contracts. 
 

▪ NOTE:  At the very minimum, you must enter information in the “Sold To”, 
and “Terms Code” in order to create a contract. 
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▪ Next, if there is going to be a Commission associated with this 
Share/Season click on the “Commission” tab. 
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▪ Select the person “Payable To” from the master client list.   

 
▪ Enter the Percent 

 
▪ Enter the Amount of the Commission to be paid.   

 
▪ Enter the Date Paid only after you have actually paid the commission to 

the person indicated. 
 

▪ Click on the Purchaser tab to get back to the Contracts section. 
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▪ After you have entered all of the information or at least “Sold To”, and 

“Terms Code” in the Season Book File Entry, click on “Contracts”. 
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▪ Click “New Contract” 
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▪ The Letter and the Contract will be created. 

o The contract module will automatically number contracts as they 
are created.  The number will contain the season year first followed 
by the automated number.   

 
▪ You can print the letter and the contract now or wait and print a batch of 

contracts/letters through the menu option “Contract Printer”. 
 

▪ Instructions for printing a batch of contracts and letters will be explained in 
the section “Contracts” > “Contract Printer”. 
 

▪ To print now, click on “File” in the menu bar at the top left of the screen 
and select print.  Once the document has printed, save the document and 
close the HFM Contract Viewer/Editor.  
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

▪ If you have printed the contract now and do not want to print this contract 
through the “Contract Printer” menu option, click on “Contract Detail”, fill 
in the Printed Date and the Sent Date and Un-check the box “Print 
Contract”. 
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▪ Close the Contract Detail screen 
 

▪ Close the Contracts screen. 
 

▪ Click “Save” on the Season Book File Entry screen.  
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▪ Repeat these steps for each contract that is to be created for each of the 
Season Book File Entries. 

▪ Make sure that you have Created a Commission Agreement Template 
before proceeding with the creation of an actual Commission Agreement.   
(See page 21-25 for creating a Commission Agreement Template) 
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▪ In the Season Book File Entry, click on the “Commission” tab and select 
the person to whom the commission is “Payable To” from the master client 
list.   
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▪ Enter the Percent. 
 

▪ Enter the Amount of the Commission to be paid. 
 

▪ *Enter the Date Paid only after the Commission has been paid out. 
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▪ When you have completed entering the Commission information click on 
the Purchaser tab to get back to the Contracts section 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

▪ Click on “Contracts” 
 

▪ Click “New Commission Agreement” 
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▪ Click “Save” to save the Commission Agreement 
 

▪ Click “Print” to print the Commission Agreement now 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

▪ Close the Commission Agreement  
 

▪ Close the Contracts screen 
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Options in the Contract List Form 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

▪ Click “New Contract” to create a new Contract based on existing Season 
Book File information.  
 

▪ Click “Edit Contract” to edit a contract that has already been created. 
First select the contract you wish to edit (if there is more than one) and 
click “Edit Contract”.  This will open the RTF (Rich Text Format) Viewer 
which will display both the Cover Letter and Contract pre-loaded. You will 
make any necessary changes to either one of the documents and then 
save the documents. 
 

▪ Click “Remove Contract” to delete a contract that has already been 
created.  Select the specific contract from the list (if there is more than 
one) and click “Remove Contract”.  

o If you are sure you want to delete the contract you have selected 
click “Yes” and the contract will be permanently removed. 
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▪ Click “Edit Commission Agreement” to open the RTF (Rich Text Format) 
Viewer which will display the Commission Agreement that corresponds 
with the selected contract. You will make any necessary changes to the 
document and then save the document. 
 

▪ Click “Contract Detail” to manually enter the Printed Date, Sent Date, 
Contract Received Date, Commission Agreement Rec’d Date, the 
Cancelled Date or to un-check the “Print Contract” option. 

o The Contract Detail screen will be auto-populated with the 
Stallion/Mare Name, the Contract Number, the Amount and the 
date that the contract was created.  **Note:  The Created Date 
cannot be changed. 

o When you actually print the contract from the Menu Option 
“Contract Printer” the Printed Date and the Sent Date will be 
populated at that time. Whatever actual date the contract was 
printed will be the date that is inserted into the “Sent Date” field as 
well as the “Printed Date” field. 

o When you receive the signed Contract back you will manually enter 
the Contract Received Date. 

o When you receive the signed Commission Agreement back you will 
manually enter the Commission Agreement Received Date. 

o If a Contract is cancelled you will manually enter the Cancelled 
Date. 

 

• Click “Close” to return to the Season Book Entry screen. 
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Printing Contracts 

(Contracts > Contract Printer) 
 

 
▪ From the Main Menu click “Contracts” then select “Contract Printer” 

 
 
 
 
 

1. Contract Proof Report (optional) 
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Determine which contracts you want to print. 
 

▪ Contract Created Date:  [Optional] Enter a date range (based on the date 
the contract was created) or leave blank to see a list of all contracts that 
have been entered for the selected Term and/ or Season Year (s). 

▪ Stud Fee Terms:  [Required] Select a Terms Code from the drop down 
list. 

▪ Contract Number: [Optional] Enter the range of contract numbers to be 
printed or leave blank to list all contracts. 

▪ Season Book 
▪ Stallion:  [Optional] Select a specific stallion from the drop down list or 

leave the Stallion as “<All>” to list all stallions. 
▪ Season Year: [Optional] Select a specific Season Year from the drop 

down list or leave the Season Year blank to see all contracts to be 
printed for all years. 

▪ Show contracts that have already been printed:  Check the box to 
show the contracts that have already been printed. 
 

▪ Once you have made your selections click “Apply Filters”. 
 

▪ You will be prompted if there are no contracts that meet your selected 
criteria. 
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▪ If there are contracts that meet the criteria you have selected, the list will 

be displayed. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

▪ Click “Print Letters” to print all of the letters associated with each contract 
that is listed. 

** Put letterhead in printer before printing the letters & select letter 
or legal paper. 

▪ Click “Print Contracts” to print all of  the contracts listed 
** Put designated paper in printer before printing the contracts & 
select letter or legal paper. 

▪ Click “Print Labels” to print all of the mailing labels for all of the contracts 
listed 

o Select the desired type of label to print from the drop down list and 
put the correct label type in the printer before printing.   
(i.e., envelopes or Avery Labels as indicated in the drop down list) 

o Start on Label:  If using sheets of individual labels you can select 
which label to start printing on if some of the labels on the sheet 
have already been used. 

▪ Click “Print Commission” Agreements to print the commission agreement 
associated with any of the contracts listed.   
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▪ After all of the contracts have been successfully printed, click “Update 
Print Flag” to automatically mark each contract as having been “Printed”. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

▪ Close the HFM Contract printer and return to the Main Menu. 
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Editing Contracts 

▪ Select Stallion > Season Book 
▪ Select the Stallion Name 
▪ Select the Season Year and Hemisphere 
▪ Select the Share/Season Number and click “Edit” 

 
 
 
 

 
 
 
 

 
 
 

 
 
 
 

 
 
 
 
 

 
 

▪ Click the “Contracts” button to edit the contract for the “Sold To” (Client 
Name) you have selected. 
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▪ Make sure the contract that you want to edit is highlighted and then click 
“Edit Contract.”  Note:  When you edit a contract the corresponding letter 
will also open for editing. 

▪ Make any necessary changes and then click File > Save or click on the 
“Save” icon.  If you make changes and save, the changes you have made 
will remain in the existing document and will re-print as such. 
 
 

Removing Contracts 
▪ Select Stallion > Season Book 
▪ Select the Stallion Name 
▪ Select the Season Year and Hemisphere 
▪ Select the Share/Season Number and click “Edit” 
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▪ Make sure the contract that you want to remove is highlighted and then 
click “Remove Contract.”   

▪ Note:  When you remove a contract the corresponding letter will also be 
removed. 

 
 
 
 

Edit the Commission Agreement 
▪ Select Stallion > Season Book 
▪ Select the Stallion Name 
▪ Select the Season Year and Hemisphere 
▪ Select the Share/Season Number and click “Edit” 
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▪ Make sure the contract for the corresponding Commission Agreement that 
you want to edit is highlighted and then click “Edit Commission 
Agreement.”   

 
▪ Make any necessary changes and then click File > Save or click on the 

“Save” icon.  If you make changes and save, the changes you have made 
will remain in the existing document and will re-print as such. 

 
 

 

Entering the Contract Detail 
▪ Select Stallion > Season Book 
▪ Select the Stallion Name 
▪ Select the Season Year and Hemisphere 
▪ Select the Share/Season Number and click “Edit” 
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▪ Make sure the contract that you want to enter information for is highlighted 
and then click “Contract Detail.”   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

▪ Enter / update any of the date fields as needed 
▪ Select to print or not print the contract 
▪ Close the Contract Detail screen 
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Re-Printing Contracts 
 
Options on how to re-print Contracts: 
 

▪ Printing from the Contract Viewer/Editor:  Follow the steps above on how 
to Edit a Contract.  When viewing the Contract you can select to print 
directly from the Contract Viewer/Editor screen. 

o Click on “File” in the menu bar at the top left of the screen and 
select print.  Once the document has printed, save the document 
and close the HFM Contract Viewer/Editor.  
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▪ Printing from the Contract Printer:  Follow the steps above on how to Edit 
a Contract and click on “Contract Details”. 

▪ Pace a “check” in the box next to Print Contract and this contract will re-
appear in the Contract Printer list.   
Reminder:  When you selected “Update Print Flag” on the Contract Printer 
screen, the information in the Contract Detail screen is automatically 
updated.   

• Printed Date is automatically filled in 
• Sent Date is automatically filled in 
• Check mark is removed from Print Contract 
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▪ On the Contract Printer screen select your criteria, click the box “Show 

contracts that have already been printed” and then click “Apply Filter.  The 
contracts that display will then re-print. 
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CONTRACT MODULE KEY WORD LISTING 

** FORMATTING EXAMPLES ** 
 

 

[[Amount]]:                                 150000 
[[Amount Formatted]]:             $150,000.00 
[[Amount Tax Formatted]]:      $9,000.00 
[[Amount Text]]:                       One Hundred Fifty Thousand Dollars And No 
Cents 
[[Amount Text All Caps]]:         ONE HUNDRED FIFTY THOUSAND DOLLARS 
AND NO CENTS 
[[Amount With Commission]]:  151010 
[[Amount With Commission Formatted]]:    $151,010.00 
[[Amount With Commission Text]]: One Hundred Fifty One Thousand Ten Dollars 
And No Cents 
[[Amount With Commission Text All Caps]]: ONE HUNDRED FIFTY ONE 
THOUSAND TEN DOLLARS AND NO CENTS 
[[Amount With Tax]]:                    159000 
[[Amount With Tax Formatted]]: $159,000.00 
[[Amount With Tax Text]]:            One Hundred Fifty Nine Thousand Dollars And 
No Cents 
[[Amount With Tax Text All Caps]]:      ONE HUNDRED FIFTY NINE 
THOUSAND DOLLARS AND NO CENTS 
[[Commission Amount]]:                       1010 
[[Commission Amount Formatted]]:    $1,010.00 
[[Commission Amount Text]]:              One Thousand Ten Dollars And No Cents 
[[Commission Amount Text All Caps]]:   ONE THOUSAND TEN DOLLARS AND 
NO CENTS 
[[Commission Payable To]]:        Smith, Jim 
[[Contract Number]]:                   201300000917 
[[Current Date]]:                          11/17/2016 
[[Current Date Formal]]:              November 17, 2016 
[[Current Date Plus Fifteen]]:      12/2/2016 
[[Current Date Plus Fifteen Formal]]:    December 02, 2016 
[[Due Date]]:                               10/5/2017 
[[Due Date Formal]]:                   October 05, 2017 
[[Due Date Year]]:                       2017 
[[Half Amount With Tax Formatted]]:      $79,500.00 
[[Half Amount With Tax Text]]:  Seventy Nine Thousand Five Hundred Dollars 
And No Cents 
[[Hemisphere]]:    N 
 
 
 



STALLION CONTRACT MODULE 
 

Date:  01/01/18 The Jockey Club Information Systems, Inc. Page 59 of 65 

 
[[Mare Boarding Farm]]:                  Smith Brothers Farm 
[[Mare Boarding Farm Address]]:   123 Any Street 
                                             Lexington, KY  40503 
[[Mare Name]]:                                Silver Spoon 
[[Mare Name All Caps]]:                  SILVER SPOON 
[[Mare Dam Name]]:                        Silver Fog 
[[Mare Dam Name All Caps]]:         SILVER FOG 
[[Mare ID]]:                                      0 
[[Mare Sire Name]]:                        Citation 
[[Mare Sire Name All Caps]]:          CITATION 
[[Next Season Year]]:                      2018 
[[Season Year]]:                              2017 
[[Second Next Season Year]]:        2019 
[[Share Holder]]:                             Dr. Cornelius Flannery, Company Name 
[[Share Holder All Caps]]:    DR. CORNELIUS FLANNERY, COMPANY                    
NAME 
[[Share Holder Percent Owned]]:   100.00 % 
[[Share Number]]:                          01 
[[Sold By Name]]:                          John Doe 
[[Sold To Address]]:                      123 Any Street 
                                                      Lexington, KY  40503 
[[Sold To City]]:                             Lexington 
[[Sold To Country]]:                      United States 
[[Sold To FAX]]:                            888-555-8343 
[[Sold To First Name]]:                 Jane 
[[Sold To Last Name]]:                  Adams 
[[Sold To Name]]:                         Ms. Jane Adams, Liberty Stable 
[[Sold To Name All Caps]]:           MS. JANE ADAMS, LIBERTY STABLE 
[[Sold To Name Client]]:               Ms. Jane Adams  
[[Sold To Name Client All Caps]]: MS. JANE ADAMS 
[[Sold To Name Farm]]:                Liberty Stable 
[[Sold To Name Farm All Caps]]:  LIBERTY STABLE 
[[Sold To Name Prefix]]:                Ms. 
[[Sold To Phone]]:                         888-555-1212 
[[Sold To State]]:                           Kentucky 
[[Sold To State Zip Country]]:       Kentucky 40503 United States 
[[Sold To Zip]]:                              40503 
[[Stallion Name]]:                          Any Stallion 
[[Stallion Name All Caps]]:            ANY STALLION 
 

 
 
 
 
 



STALLION CONTRACT MODULE 
 

Page 60 of 65 The Jockey Club Information Systems, Inc. Date: 07/01/17 

 

 

CONTRACT REPORTS  
 

 

 

 
 
 
 
     Contract Reports 
 
 
 
 
 
 
 
Report Name:  
 
Purpose: Prints a listing of all Contracts in the system. 
 
Accessed From: Contracts menu 
 
Selection Criteria: Contract Creation Date (Starting Date & Ending Date), 

Stallion Name, Contract Number, Share Number and 
optional selection to show only contracts flagged for 
printing 

 
Report Order: Contract Number 
 
Special Notes: None 
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Report Name:      

 
Purpose: Prints detailed information on the current status of each 

Contract in the system.  
 
Accessed From: Contracts menu 
 
Selection Criteria: Season Year (Required), Hemisphere, Stallion Name, 

Contract Status (Received, Sent, Both and an option to 
include Contracts that have been Cancelled) 

 
Report Order: Stallion Name / Status / Share/Season Number 
 
Special Notes: None 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



STALLION CONTRACT MODULE 
 

Page 62 of 65 The Jockey Club Information Systems, Inc. Date: 07/01/17 

 

 
 

Report Name:      

 
Purpose: Prints a list comparing the status of Contracts (Sent, 

Received, Cancelled, Pending and Total) for the Thru 
Date selected vs. the same time frame the previous year. 

 
Accessed From: Contracts menu 
 
Selection Criteria: Thru Date and Stallion Name 
 
Report Order: Stallion Name 
 
Special Notes: None 
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Report Name:      

 
Purpose: Provides a summary of how many Contracts have been 

Created, Sent, Received and Cancelled based on the 
Season Book Status. 

 
Accessed From: Contracts menu 
 
Selection Criteria: Season Year (Required), Hemisphere, Stallion Name and 

an optional selection to list only stallions standing at 
farm’s facilities 

 
Report Order: Stallion Name 
 
Special Notes: None 
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Report Name:       

 
Purpose: Prints a report showing all Commission Agreement 

information in the system for the selected Season Year. 
 
Accessed From: Contracts menu 
 
Selection Criteria: Season Year (Required), Hemisphere, Stallion Name, 

Agent Name and optional grouping by Agent or Stallion 
 
Report Order: Commission Payable To (Client Name) 
 
Special Notes: None 

 

 

 
 

 
  



STALLION CONTRACT MODULE 
 

Date:  01/01/18 The Jockey Club Information Systems, Inc. Page 65 of 65 

 

HOW TO REACH US 
 
 
 

The Jockey Club Information Systems, Inc. 
821 Corporate Drive 
Lexington, KY   40503 

 
Phone: (800) 333-1778 
             (859) 224-2800 

 
Fax:   (859) 224-2810 

 

E-Mail:  support@tjcis.com 

 
 

 
Regular business hours: 

 8:00 am – 5:00 pm (EST)  Monday – Friday 
 

 
 
 

Web Address for More Information 
 

www.horsefarmmanagementsoftware.com 
 

or 
 

www.tjcis.com 
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